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Ejercicio 2: Detección de Cambios mediante la 
Clasificación Supervisada  

Objetivos 

• Entender cómo superponer las bandas de dos fechas     
• Generar sitios de entrenamiento para una clasificación supervisada  
• Utilizar el software R para ejecutar el algoritmo Random Forest para realizar una 

clasificación supervisada para la detección de cambios 
• Aplicar un esquema cromático para interpretar los cambios a través del tiempo 
• Realizar el post-procesamiento de una imagen para mejorar la exactitud de la 

clasificación de ésta 
 

Resumen de Temáticas 

• La superposición de bandas y el mejoramiento de imágenes 
• Desarrollar sitios de entrenamiento 
• Algoritmo de clasificación Random Forest  
• Post-procesamiento de la imagen clasificada 

Herramientas Necesarias 

• QGIS 3.2 para Windows OS 
• El programa estadístico R (versión 3.3.0 o superior) 
• R Studio 

Datos Asociados  

Para este ejercicio va a necesitar los archivos de las imágenes del ejercicio de la 
primera semana:  

• Tanzania1993_Clip.tif 
• Tanzania2016_Clip.tif 
• Y también debe descargar el script para R “classification.R” de la página de 

ARSET aquí: https://arset.gsfc.nasa.gov/land/webinars/adv-change18  
• Cree una carpeta llamada Ejercicio2 y en ésta guarde el script 

 
 
 
 

http://arset.gsfc.nasa.gov/
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Introducción 

Para este ejercicio vamos a analizar los cambios en la vegetación en Tanzania de 1993 
a 2016 utilizando una técnica de clasificación supervisada. Vamos a utilizar datos de 
Landsat de estas dos fechas. Para la primera imagen de 1993, vamos a usar datos de 
Landsat 5 y las imágenes de 2016 van a ser de Landsat 8. Vamos a superponer las 
bandas de ambas imágenes juntas y utilizar el algoritmo Random Forest para generar 
una imagen de los cambios. Esta imagen indicará las regiones donde la cobertura 
boscosa ha incrementado, disminuido, o sigue igual. Se puede aplicar esta técnica a 
muchas regiones diferentes y podría incluir diferentes tipos de clasificación de 
imágenes para su región de interés.  
 
Parte 1: Superposición de Imágenes y Mejoramiento de Imágenes  

1. Abra QGIS 
2. En el panel superior haga clic en Layer > Add Layer > Add Raster Layer 

 
 

3. Navegue a su carpeta Ejercicio1 y agregue los archivos Tanzania1993_Clip.tif y 
Tanzania2016_Clip.tif. Haga clic en Add, después en OK y después en Close. 
Asegúrese que la imagen de 1993 esté encima de la imagen de 2016 en el panel 
Layers.   
 

http://arset.gsfc.nasa.gov/
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4. Haga clic en Raster > Miscellaneous > Merge para superponer las bandas de 
las dos imágenes juntas en una imagen 

a. Haga clic en el  al lado de Input Layers y haga clic en Select all para 
seleccionar ambas imágenes. También debe asegurarse de que la 
imagen de 1993 esté sobre la imagen de 2016 en las Capas de entrada. 
Haga clic en OK.  

b. Seleccione el botón Place each input file into a separate band  
c. Deje el Output data type con el valor preprogramado de Float32  
d. Haga clic en el  al lado de Merged y seleccione Save to File. Guarde 

el nuevo archivo como Tan1993_2016_Stacked.tif en su carpeta 
Ejercicio2.  

e. Haga clic en Run in Background 
f. Una vez que el procesamiento esté completo, haga clic en Close 

5. La nueva imagen temporal combinada será agregada al mapa. Navegue a su 
carpeta Ejercicio2 y haga clic en Layer > Add Layer > Add Raster Layer y 
seleccione el archivo Tan1993_2016_Stacked.tif. Haga clic en Add, después en 
OK y después en Close. 

6. Remueva la imagen temporal combinada haciendo clic con el botón derecho 
sobre ésta en el Layers Panel y seleccionando Remove Layer. Haga clic en OK 
cuando se abra la nueva ventanilla.  

http://arset.gsfc.nasa.gov/
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7. Haga clic en el icono de Save Project As   para guardar su Proyecto como 
Ejercicio2.qgz 

Ahora, vamos a mejorar la imagen como lo hicimos en el ejercicio de la primera 
semana. Note que esta nueva imagen tendrá todas las bandas de la imagen de 1993 y 
de la imagen de 2016. Las diferentes combinaciones de bandas le permiten visualizar 
las imágenes de maneras diferentes. Hay varias diferentes combinaciones de bandas 
que típicamente se utilizan para observar los cambios en la vegetación incluyendo color 
real, color infrarrojo y compuestos de color falso (ver el enlace a seguir).  
 
https://landsat.usgs.gov/how-do-landsat-8-band-combinations-differ-landsat-7-or-
landsat-5-satellite-data  
 
En este ejercicio vamos a visualizar la imagen utilizando la combinación compuesta de 
bandas color falso. Es útil crear una combinación de bandas para el primer período de 
tiempo, una para el segundo período de tiempo y una que contiene combinaciones de 
ambas fechas para resaltar los cambios. En QGIS uno puede crear copias de su 
imagen de dos fechas y luego asignar las combinaciones de bandas únicas a cada una. 
 

http://arset.gsfc.nasa.gov/
https://landsat.usgs.gov/how-do-landsat-8-band-combinations-differ-landsat-7-or-landsat-5-satellite-data
https://landsat.usgs.gov/how-do-landsat-8-band-combinations-differ-landsat-7-or-landsat-5-satellite-data
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8. Para crear una copia, haga clic con el botón derecho en 
Tan1993_2016_Stacked.tif y seleccione Duplicate. Esto creará una nueva 
imagen con el suffix _copy, al cual uno puede asignar diferentes combinaciones 
de bandas.  

9. Cámbiele el nombre a la primera copia haciendo clic con el botón derecho en la 
copia y seleccionando Rename Layer. Cámbiele el nombre a 
Tan1993_2016_Stacked_1993.tif. 

10. Cree otra copia y cámbiele el nombre a Tan1993_2016_Stacked_2016.tif. 
11. Cambie el nombre de la imagen Tan1993_2016_Stacked original a 

Tan1993_2016_Stacked_Change 
12. Remueva las imágenes Tanzania1993_Clip y Tanzania2016_Clip.  

a. Puede remover más de una imagen haciendo clic en ellas en el Layers 
Panel y haciendo clic con el botón derecho y seleccionando Remove 
Layer 

13. Apague todas las capas menos Tan_1993_2016_Stacked_1993 
14. Haga clic con el botón derecho en la imagen Tan_1993_2016_Stacked_1993 en 

el Layers Panel y haga clic en Properties. Se abrirá una ventanilla que llevará 
directamente a la pestaña Symbology.  

a. Deje el Render type con el valor preprogramado de Multiband color  
b. Cambie la Red band a Band 5 
c. Cambie la Green band a Band 4 
d. Cambie la Blue band a Band 3 

15. Haga clic en Apply 
16. Haga clic en la flecha para abrir un menú desplegable al lado de los Min/max 

value settings 
17. Active el Mean +/- standard deviation y asegúrese que el valor esté 

configurado como 2.00 (éste debe ser el valor preprogramado)  
18. En el menú desplegable al lado de Statistics extent, puede dejar el valor 

preprogramado de Whole raster 
a. Haga clic en Apply y después en OK.  

http://arset.gsfc.nasa.gov/
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19. Repita los pasos 13-17 para la imagen Tan_1993_2016_Stacked_2016. Todos 

los pasos serán los mismos menos las combinaciones de colores. Recuerde que 
las bandas de 2016 están superpuestas después de las bandas de 1993, así 
que: 

a. Cambie la Red band a Band 12 
b. Cambie la Green band a Band 11 
c. Cambie la Blue band a Band 10 

Note que las bandas 12, 11 y 10 corresponden a las bandas 6, 5 y 4 de la imagen 
Landsat 8 de 2016. El motivo es porque tenemos seis bandas de nuestra imagen de 
Landsat 5 de 1993 superpuestas sobre las 8 bandas de Landsat 8 de 2016. Ésta es la 
misma visualización de color falso.  
 

 
 

20. Repita los pasos 13 a 15 para la imagen Tan_1993_2016_Stacked_Change. 
Esta vez, cambie las bandas de la siguiente manera: 

a. Cambie la Red band a Band 13 
b. Cambie la Green band a Band 5 
c. Cambie la Blue band a Band 8 

http://arset.gsfc.nasa.gov/
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21. Esta vez elija la opción Cumulative count cut bajo Min/ max values 
settings y déjela con el valor programado de 2.0 y 98.0%.  

22. En el menú desplegable al lado de Statistics extent puede dejar el valor 
preprogramado de Whole raster.  

23. Haga clic en Apply y después en OK.  

Notará que las áreas deforestadas están resaltadas en magenta/morado y las áreas 
con un incremento de vegetación están resaltadas en verde. Esta combinación de 
bandas utiliza bandas de ambas fechas en un compuesto para resaltar cambios en las 
bandas Infrarroja onda corta (Shortwave Infrared o SWIR) 13 (o la banda 7 
correspondiente de la imagen de Landsat 8 de 2016) y 5 (de la imagen de Landsat 5 de 
1993). Al utilizar esta combinación, se pueden ver los cambios de la primera fecha 
hasta la segunda.  

 

 
 
 
Parte 2: Desarrollando Sitios de Capacitación 

1. Cree un nuevo shapefile poligonal haciendo clic en Layer en la parte superior 
del menú. Haga clic en Layer > Create Layer > New Shapefile Layer. O haga 

http://arset.gsfc.nasa.gov/
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clic en el icono New Shapefile Layer  al lado izquierdo. 
a. File name: Haga clic en el  al lado de File name y navegue a su 

carpeta Ejercicio2 y póngale el nombre training.shp al archivo. Haga clic 
en Save. 

b. File encoding: UTF-8 (posiblemente sea el valor preprogramado) 
c. Geometry type: Utilice el menú desplegable para elegir Polygon 

i. Bajo Geometry type: EPSG:32637 - WGS 84 / UTM zone 37N – 
Projected OR Project CRS: EPSG:32637 – WGS 84 / UTM zone 
37 N (el nombre podría aparecer un poco diferente dependiendo de 
si utiliza un Mac o un PC).  

ii. Esto se hace para asegurar que nuestro Sistema de referencia sea 
el mismo que la imagen de Landsat.  

d. Bajo New field > Name: teclee Notes 
e. Type: Text data 
f. Length: 20 
g. Haga clic en Add to fields list 
h. Haga clic en OK 

 

http://arset.gsfc.nasa.gov/
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Para crear sitios de entrenamiento, queremos identificar áreas donde sabemos la 
categoría de cobertura terrestre y el tipo de cambio observado de 1993 a 2016. Para 
este ejercicio, vamos a utilizar estas categorías y códigos:  

 
Clase de Cobertura Código 
Bosque a Bosque 11 
Bosque a No-Bosque 12 
No-Bosque a No-Bosque 22 
No-Bosque a Bosque 21 

 
 
Para mantener este ejercicio sencillo, vamos a utilizar dos tipos de cobertura terrestre: 
bosque y no-bosque. Estas categorías o seguirán siendo las mismas de 1993 a 2016 
(bosque a bosque y no-bosque a no-bosque) o cambiarán a la otra categoría de 
cobertura terrestre (bosque a no-bosque o no-bosque a bosque). Para la detección de 
cambios de diferentes regiones en el futuro, probablemente tenga más categorías de 

http://arset.gsfc.nasa.gov/
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cambio (ej. suelo descubierto, agua, urbano).  
  

1. Asegúrese que las capas estén en este orden en el Layers Panel: (1) polígono 
de entrenamiento, (2) la imagen de los cambios, (3) la imagen de 1993 y (4) la 
imagen de 2016. 

2. Primero vamos a delinear los sitios de entrenamiento donde hay bosque en 1993 
y 2016 (no hay cambio). Revise la imagen de los cambios primero. Las áreas 
oscuras por lo general son áreas que no han cambiado. Para confirmar si esto 
es cierto, apague la imagen de los cambios y alterne entre las imágenes de 1993 
y 2016.  

a. Puede apagar y encender las capas haciendo clic en la marca de 
verificación al lado de cada imagen en el Layers Panel.  
 

Una vez que haya encontrado una región sin ningún cambio, de bosque a bosque, 
dibujará un polígono alrededor de esos pixeles para crear el sitio de entrenamiento. 
Puede ampliar y reducir las imágenes y apagar y alternarlas hasta que tenga confianza 
de haber encontrado una región sin cambios de bosque a bosque de 1993 a 2016. 
 

3. Para dibujar polígonos, haga clic en la capa training en el Layers Panel y 

seleccione Toggle editing o haga clic en el icono de Toggle editing   
mientras la capa vectorial está resaltada en el Layers Panel. Esto le permitirá 
editar el shapefile poligonal. Estos polígonos servirán de sitios de entrenamiento 
para la clasificación. 

4. Para agregar atributos a la capa (las cuales servirán de sitios de entrenamiento), 

haga clic en el icono de Add Polygon Feature   en el Digitizing Toolbar o 
haga clic en Edit y seleccione Add Polygon Feature. Después de seleccionar 
Add Polygon Feature aparecerá un retículo cuando desplace su ratón sobre la 
imagen. 

5. Haga clic en la imagen para delinear un polígono que solo incluya pixeles sin 
ningún cambio de bosque a bosque. Haga clic con el botón derecho para cerrar 
el polígono. 

6. Aparecerá un cuadro de diálogo para brindar información sobre los atributos. 
Póngale a este polígono el número ID 11. En Notes ponga Bos-Bos. Haga clic 
en OK. 

 

http://arset.gsfc.nasa.gov/
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7. Repita los pasos 4 a 6 para otras áreas forestadas sin cambios en la imagen 
hasta que tenga por lo menos 10 sitios de entrenamiento con ID 11. Asegúrese 
de crear polígonos con abundantes pixeles a lo largo de la imagen.  

 
 

 

http://arset.gsfc.nasa.gov/
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Ahora vamos a crear sitios de entrenamiento que eran bosque en 1993 pero que 
eran suelo descubierto (no bosque) en 2016. Estas áreas serán moradas/magentas en 
la imagen de los cambios. Nuevamente, puede confirmar este tipo de cambios 
haciendo clic para apagar y visualizar la imagen de 1993 y la de 2016.  
 

8. Repita los pasos 4 a 6 para la categoría bosque a no-bosque. Asígnele el 
número ID 12 a cada uno de estos polígonos de entrenamiento y en las notas 
teclee Bos-NoBos. 

9. Si está teniendo dificultad para ver los polígonos que está creando, puede 
cambiar el color a rojo. Haga clic con el botón derecho en la capa de 
entrenamiento en el Layer Panel. Haga clic en Styles y haga clic en el área roja 
de la rueda decolores. Esto automáticamente volverá todos los polígonos rojos.  

Ahora vamos a crear sitios de entrenamiento que eran no-bosque tanto en 1993 como 
en 2016. Estas áreas se indicarán en blanco en la imagen de cambios. Notará un 
pueblo en la región norte-centro de la imagen; ésta es una buena área para indicar esta 
categoría de no-bosque a no-bosque. Nuevamente, puede confirmar este tipo de 
cambio alternando entre la imagen de 1993 y la de 2016.  
 

10. Repita los pasos 4 a 6 para la categoría no-bosque a no-bosque. Asígneles a 
estos polígonos el número ID 22 y en las notas teclee NoBos-NoBos. 

Finalmente, crearemos sitios de entrenamiento que fueron no-bosque en 1993 pero 
bosque en 2016. Estas áreas se indicarán en verde en la imagen de cambios. 
Nuevamente, puede confirmar este tipo de cambio alternando entre la imagen de 1993 
y la de 2016.  
 

11. Repita los pasos 4 a 6 para la categoría no-bosque a bosque. Asígnele el 
número ID 21 a cada uno de estos polígonos y en las notas teclee NoBos-Bos. 

Después de haber creado todos sus sitios de entrenamiento para las cuatro categorías 
debe guardar las ediciones de las capas. 

12. Haga clic en el icono de Save Layer Edits  o haga clic con el botón derecho 
en la capa de entrenamiento en el Layers Panel y haga clic en Save Layer 
Edits 

13. Apague la edición por Toggle haciendo clic en el icono de Toggle editing  
para que ya no esté resaltado 

14. Recuerde siempre guardar (Save) su mapa durante el proceso 

 
 

http://arset.gsfc.nasa.gov/
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Parte 3: El Algoritmo de Clasificación Random Forest  

Ahora vamos a ejecutar el algoritmo de clasificación Random Forest (bosque aleatorio) 
para generar el mapa de cambios clasificados. Vamos a hacer esto utilizando el 
software R y R Studio.  
 

1. Abra R Studio  
2. En el panel superior, haga clic en File > Open File. Navegue a su carpeta 

Ejercicio2 y abra el archivo classification.R.  

 
 
Como primer paso, es buena idea designar el directorio operativo como la carpeta que 
contiene el shapefile del sitio de entrenamiento y la superposición de las dos imágenes 
 

3. Vaya a Session > Set working directory > Choose Directory y fíjelo como su 
carpeta Ejercicio2  

a. Necesitará asegurarse que todas sus imágenes y su archivo training.shp 
estén ubicados en esta carpeta sin ninguna subcarpeta.  

 

http://arset.gsfc.nasa.gov/


 
 Capacitación en Línea Avanzada: Detección de Cambios para el            

Mapeo de la Cubierta Terrestre 
28 de septiembre y 5 de octubre de 2018 

 

http://arset.gsfc.nasa.gov/   15  

 
 

4. Ahora necesitamos instalar unos cuantos paquetes específicos. Vaya a Tools > 
Install Packages. 

5. Teclee los siguientes paquetes separados por un espacio: maptools, sp, 
randomForest, raster, rgdal 

a. Nota: mientras teclee los nombres de estos paquetes, posiblemente 
aparezcan en una lista desplegable generada, de la cual puede 
seleccionar para asegurarse que el nombre esté correcto. Además, si 
está trabajando en un Mac, puede que necesite instalar el paquete rgeos.  

6. Haga clic en Install  
a. El proceso se iniciará y puede que tarde unos minutos para asegurar que 

cada paquete esté instalado. Una vez que los paquetes estén instalados, 
la consola de R mostrará una > azul.  

 
 

http://arset.gsfc.nasa.gov/
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Ahora vamos a tener que cambiar unas cuantas líneas del código de R 
específicas a la ubicación de las imágenes y el archivo training.shp para su 
computadora individual  
 
Primero, indique el directorio operativo: 

1. Desplácese hacia abajo hasta la línea 65 del código de R que comienza con 
setwd. Va a necesitar cambiar esta línea para identificar su directorio operativo.  

2. Cambie las partes en rojo para navegar a su carpeta Ejercicio2 en su 
computadora. Puede ver cómo esta ruta es si va a su carpeta de Windows o a la 
ventanilla del buscador si está trabajando en una Mac. Note también que en una 
Mac, puede navegar a su carpeta Exercise2, hacer clic en File > Get Info y 
copiar la ruta al lado de Where.   

Initial Directory: 
 
setwd("C:/Users/amccullu/Documents/ARSET/Change_Detection/Exercise2") 
 
*Nota: en este ejemplo, esta ruta navega a una carpeta llamada Exercise2. NO importa 
necesariamente qué nombre le ponga a su carpeta con tal de tenerlo escrito 
correctamente en el script.  

 
 
Ahora cambie el nombre y la ruta para su shapefile de entrenamiento: 
  

3. Desplácese hacia abajo hasta la línea 67 del código R. Cambie las partes en 
rojo para navegar a su shapefile de capacitación en su carpeta Exercise2.  

http://arset.gsfc.nasa.gov/
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Directorio Inicial:  
 
shapefile <-
'/Users/amccullu/Documents/ARSET/Change_Detection/Ejercicio2/EX2_Practice/trainin
g.shp' 
 
Dejará todas las demás partes del código R sin ninguna modificación. Si le interesa, 
puede desplazarse en el código de R para aprender cuáles son los pasos. Por ejemplo:  

• Línea 69: classNums <- c(11,12,21,22): Estas son las clases que identificamos 
en el shapefile de entrenamiento 

• Línea 72: classSampNums <- c(100,100,100,100): Este es el número 
aproximado de muestras de entrenamiento a ser seleccionadas de manera 
aleatoria para ejecutar el algoritmo Random Forest  

• Línea 74: attName <- 'id': Éste es el atributo que el código utiliza para realizar la 
clasificación 

• Línea 76: nd <- -9999: Este valor significa que no hay datos 
• Línea 78: inImageName <-'Tan1993_2016_Stacked.tif': Ésta es la imagen de 

entrada que el código está utilizando para la clasificación 

Puede leer el resto del código y leer las anotaciones (con el # en verde) para ver qué 
es lo que el código está haciendo.  

7. Guarde el código R haciendo clic en el icono de Save  en la parte superior.  

8. Haga clic en el icono Source  en la parte superior para ejecutar el 
código entero 

a. Verá cada uno de los pasos ejecutarse en la consola R en la parte inferior 
9. Aparecerá un mensaje que dice: Type n to stop, c to change feature space 

bands, s to define a rectangle to locate gaps in feature space, or any other key to 
continue with random forests model creation and prediction: 

10. Haga clic en la tecla K y el resto del código se ejecutará. Durante el proceso, 
esto se verá al fondo mientras que cada parte se ejecute:  

 

El código R creará una matriz de confusión y la visualizará en la consola R también. 
Cuando el proceso entero esté completo, la consola R visualizará el tiempo de 
procesamiento y posiblemente reciba un mensaje de advertencia que dice: 
readShapePoly is deprecated; use rgdal::readOGR or sf::st_read. Esto está bien. 
Probablemente se ha ejecutado bien el proceso.  
 

http://arset.gsfc.nasa.gov/
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11. También puede chequear dos veces si el algoritmo Random Forest se 
ejecutó. Navegue a su carpeta Ejercicio2 y encuentre el archivo 
Tan_1993_2016_Stacked_Class.tif. 

12. Cierre R Studio. Aparecerá una ventanilla para preguntarle si desea Save the 
Workspace Image. Haga clic en Yes o Save en un Mac.  

Parte 4: Post-Procesamiento de la Imagen Clasificada  

En este paso final, vamos a volver a QGIS y visualizar, colorear y “limpiar” nuestra 
imagen clasificada 

1. Vuelva a QGIS. Haga clic en el icono de Add Raster Layer   .  
2. Navegue a su carpeta Exercise2 y agregue la imagen 

Tan1993_2016_Stacked_Class.tif Haga clic en Add, después en OK, después 
en Close. 

Notará que la imagen tiene valores del 11 al 22, los cuales son en realidad las 
categorías que definimos en la parte 3 de este ejercicio.  
 
*Nota: Si su imagen contiene valores del 1 al 4, suponga que 1=11, 2=12, 3=21 y 4=22. 
Puede ingresar los valores correctos al archivo en el paso 4 a seguir. Puede que ésta 
sea una diferencia entre cómo QGIS funciona en una Mac versus un PC. 
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3. Haga clic con el botón derecho en la imagen 
Tan1993_2016_Stacked_Class en el Layers Panel. Haga clic en Properties > 
Symbology.  

a. Render Type: Singleband Pseudocolor 
b. Interpolation: Linear o Exact (ambos sirven) 
c. Mode: Equal Interval 
d. Cambie el Number of Classes a 4 
e. Haga clic en Classify. 

4. Cambie los Values y Labels a:  
a. Value: 11 o 1; Color: black; Label: Forest a Forest  
b. Value: 12 o 2; Color: red; Label: Forest a Non-Forest  
c. Value: 21 o 3; Color: green; Label: Non-Forest a Forest  
d. Value: 22 o 4; Color: yellow; Label: Non-Forest a Non-Forest  

5. Para cambiar los colores puede hacer clic dos veces en el icono de colores para 
seleccionar los colores que le parezcan apropiados para identificar las 
categorías. Puede elegir colores diferentes a los del ejemplo si lo desea.  

6. Haga clic en Apply 
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7. Haga clic en el icono de Export Color Map to File   
8. Navegue a la carpeta Exercise2 y guarde el archivo como classcolors.txt  
9. Haga clic en OK para cerrar la ventanilla de Layer Properties  

 
 

 
 
Ahora vamos a utilizar el Majority Filter para remover algo del ruido o “speckle” de la 
imagen.  
 

10. Haga clic en Processing > Toolbox. La Toolbox (caja de herramientas) debería 
aparecer a mano derecha.  

11. Teclee Majority Filter en la casilla de búsqueda y haga clic dos veces en la 
herramienta Majority Filter.  

a. Grid (cuadrícula): Asegúrese que Tan1993_2016_Stacked_Class 
[EPSG:32637] esté seleccionado. Debería estar así automáticamente. 

b. Deje los otros atributos con su valor preprogramado y haga clic en el  
al lado de Filtered Grid. Navegue a su carpeta Ejercicio2 y guarde el 
nuevo archivo como Tan1993_2016_Stacked_Class_3x3.sdat. 
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12. Haga clic en Run 
13. Este proceso hará abrir otra ventanilla para ejecutarse y cuando el 

procesamiento esté completo la nueva cuadrícula temporal Filtered Grid se 
agregará al mapa  

14. Haga clic en Close para cerrar el Majority Filter. 
15. Remueva el archivo temporal Filtered Grid del mapa y agregue 

Tan1993_2016_Stacked_Class_3x3.sdat usando la funcionalidad Add Raster 
Layer  

16. Haga clic con el botón derecho en Tan1993_2016_Stacked_Class_3x3.sdat y 
haga clic en Properties > Symbology  

a. Render Type: Singleband Pseudocolor  

b. Bajo Style, seleccione Load color map from file   
c. Abra el archivo colorclass.txt  
d. Haga clic en Apply y en OK 

17. Cierre la ventanilla de Properties. Encienda y apague la imagen 
Tan1993_2016_Stacked_Class_3x3 y podrá ver que el “speckle” o el ruido ha 
sido removido de la nueva imagen.  
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Ahora vamos a realizar un último paso de post-procesamiento llamado Sieve 
(que significa colador). Esto removerá los pequeños racimos de pixeles que están 
incorrectamente clasificados.  
 

18. Haga clic en Processing > Toolbox. La caja de herramientas debe aparecer a 
mano derecha.  

19. Teclee Sieve en la casilla de búsqueda y haga doble clic en la herramienta 
Sieve.  

 
20. Ingrese estos parámetros en la herramienta Sieve:  

a. Input Layer: Tan1993_2016_Stacked_Class_3x3.sdat 
b. Threshold: 10 (éste debería ser el valor preprogramado) 
c. Haga clic en el cuadro de Use 8-connectedness  
d. Haga clic en el  al lado de Sieved: Guarde el archivo como 

Tan1993_2016_Stacked_Class_3x3_se.sdat 
e. Haga clic en: Run in background 
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21. Haga clic en Close para cerrar la herramienta Sieve 
22. Remueva el archivo temporal con Sieve del mapa y agregue el archivo 

Tan1993_2016_Stacked_Class_3x3_se.sdat utilizando la función Add Raster 
Layer  

23. Haga clic con el botón derecho en 
Tan1993_2016_Stacked_Class_3x3_se.sdat y haga clic en Properties > 
Symbology  

a. Render Type: Singleband Pseudocolor  

b. Bajo Style, seleccione Load color map from file   
c. Abra el archivo colorclass.txt  
d. Haga clic en Apply y en OK 

24. Cierre la ventanilla de Properties. Encienda y apague la imagen 
Tan1993_2016_Stacked_Class_3x3_se y podrá ver que ésta representa otro 
mejoramiento en la clasificación.   

Para poder tener una clasificación exacta, a menudo se requiere realizar múltiples 
iteraciones de la creación de sitios de entrenamiento y re-ejecutar el algoritmo Random 
Forest. Aunque no vamos a repasar este proceso una vez más, será útil en su estudio 
específico de su área de interés.  
 

25. Exporte el mapa final. Haga clic con el botón derecho en 
Tan1993_2016_Stacked_Class_3x3_se.sdat y haga clic en Export > Save As 

26. Haga clic en el  al lado de File name. Navegue a su carpeta Ejercicio2 y 
guarde el archivo como Tan1993_2016_ChangeFinal.tif 
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27. Haga clic en OK 

 
28. Su nueva imagen será agregada a su mapa. Puede cambiar el esquema 

cromático para que sea igual al otro si desea.  
29. Save (guarde) su mapa y salga de QGIS.  
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Conclusión 

En este ejercicio, utilizamos dos imágenes (de 1993 y 2016) para identificar cambios en 
el paisaje. Primero, superpusimos las dos imágenes para utilizar las bandas de cada 
imagen para identificar regiones donde el bosque había incrementado, disminuido, o no 
hubo cambios. Después generamos sitios de entrenamiento que se utilizaron en el 
algoritmo de clasificación Random Forest para crear una imagen clasificada que resalta 
cambios o la falta de cambios. Finalmente, utilizamos técnicas de filtrado para reducir 
los ruidos o la incertidumbre en la imagen. Estas técnicas se pueden aplicar a varios 
diferentes paisajes que pueden tener varios diferentes tipos de cobertura terrestre y de 
cambios.  
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